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RefWorks 2.0 Quick Start Guide

Logging In
= Access www.refworks.com/refworks. Enter your personal Login

Name and Password. (First-time users need to sign up for a New
Account following the screen prompts.)

» NOTE: Remote users, accessing RefWorks from off-site or from
a nonregistered IP address, must either enter the “Group Code”
prior to the personal Login Name and Password or log-in via the
organization’s proxy server or log in using other organizational
credentials (Athens, Shibboleth, etc.).

Need More Help?

Online Tutorial

A tutorial providing explanations of various RefWorks functions is
available within every RefWorks account. Use the Help pull-down
menu to access the tutorials.

Support

Online
Use the Help pull-down menu to access detailed instructions,
frequently asked questions, and much more.

E-Mail
Send questions or problems to support@refworks.com.

Webinars

RefWorks-COS now offers a variety of complimentary training
webinars. A complete listing of sessions can be found at
www.refworks-cos.com/training. New dates and time are
added monthly.

Phone
Contact RefWorks Technical Services at +1.775.327.4105.



Creating Your RefWorks Database

RefWorks provides a number of options for adding data to your database.

Importing Data Directly
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1. Under the save or export function within the online service,
select or click the Save to RefWorks option. (A1)

2. If you have your RefWorks account already open, the import
should automatically begin. If not, then you will be prompted to
log in to RefWorks; after you login, the import will
automatically begin.

3. Click the View Last Imported Folder to review the imported records.

Helpful Hint: Every reference added to RefWorks (whether imported
or entered manually) is given a print or electronic designation called
Source Type. This assists in ensuring you have all the relevant data
REQUIRED in your bibliography. A default Source Type may have
been set by your local Administrator. Users can set their own source
type in the Customize area. (A2)

Converting References from Other
Bibliographic Management Products

RefWorks is compatible with a number of other bibliographic
management products. You can easily convert an existing
bibliographic management database such as EndNote into
RefWorks. For details related to importing data from specific
individual bibliographic management products, please refer
to the online Help section of RefWorks.
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Importing Data from Saved Text Files
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References can be imported into RefWorks from a text file (.txt) created
by saving references from a wide variety of online services and other
bibliographic management programs.

—

. Retrieve the results you want to export from the online service
or bibliographic manager, and save them as a text file. If the
database vendor lists several different formats for saving the
references, see the RefWorks Help file for further details on the
appropriate selection.

2. Access your RefWorks account and click References from the
drop-down menu; then select Import.

3. On the subsequent menu, access the drop-down menu next to
Import Filter/Data Source and click the source of the data. (B)

4. Click on the Database drop-down menu and select the
source database.

5. Click on the Browse button to select the text file to import.

6. Click on the Import into Folder drop-down menu to designate
the specific folder where you want to file the imported references.
By default, references will automatically be placed in the Last
Imported folder, even if you designate an existing folder for them
to go to.

7. Click on Import. When the import is complete, click the

View Last Imported Folder button to review and modify the

imported references.

Helpful Hint: An up-to-date listing of all online services and databases
that are supported by RefWorks can be found on the RefWorks-COS
website at www.refworks-cos.com.

Importing from RSS Feeds

RefWorks has integrated an RSS Feed Reader so you can easily add
your favorite RSS Feeds from publishers and websites, view the
information and import data into your RefWorks database.

1. Locate the RSS Feed you wish to include.
2. Right mouse-click on the RSS Feed icon or link and select
Copy Shortcut.
3. From within RefWorks, select RSS Feed from the Search Menu.
4. Paste the shortcut into the text bar and click the Add RSS
Feed button.
5. Confirm the addition of the RSS Feed by clicking OK. Your feed
results will be displayed in a new window. Select the references
you wish to import into your RefWorks account and click Import.



Creating Your RefWorks Database (continuea)

RefWorks provides a number of options for adding data to your database.

Manually Entering References
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1. Click on the New Reference button.

2. Select a potential bibliographic output style (e.g., APA,

Chicago, MLA) under View fields used by to enable the
AccuCite feature. (C)

3. Designate the type of reference you are entering (e.g. journal,
book or dissertation) under Ref Type. The field names that are
associated with the specific output style and reference type
you chose will appear, indicating recommended information
needed to produce an accurate bibliography. These fields are
not required to save the actual reference in RefWorks. To view
additional fields, click on Additional Fields at the bottom
left of the window.

4. Enter information in the boxes provided and click the
appropriate Save button when finished.

Attaching Files to a Reference
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You can attach files when adding a new reference manually

or editing an existing reference. Attachments can be any

type of computer file (PDF, TIF, JPG, GIF etc.) that you want to
associate with the bibliographic information you store in your
RefWorks database. For further instructions on attaching files
to your references, please refer to the Help file.

1. Select a reference in your database; click on the Edit button ().
2. Click on Browse. Select a file to attach. Select Open.
3. Click on Add attachment. (D)

Helpful Hint: The number of files that you can attach to a reference
is determined by your local RefWorks administrator. The maximum
size of any individual attachment is 20 MB. (The default setting for
attachments in an account is 100 MB. The RefWorks administrator
may increase this setting up to 5 GB per account.)

Note: The Attachment Feature is not available for individual subscriptions.
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Importing from Online Catalogs
or Databases
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You can use RefWorks as a search interface for a number of online
resources. (E) RefWorks provides access to many publicly available
services such as NLM’s PubMed as well as many universities’ Online
Catalogs. Additionally, institutional subscribers may also provide
access to subscription-based online services (e.g., Ovid or ProQuest)
through RefWorks.
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. From the Search pull-down menu, select Online Catalog or

Database.

. Select a database from the Search drop-down menu.
. Select the Max. Number of References to Download from the

drop-down menu.

. Enter terms in either the Quick Search for: or run an Advanced

Search by clicking on the triangle in the Advanced Search for:
box to enter terms.

. Click on Search to begin your search.
. Your results will be displayed. Select the references you wish to

import into your RefWorks account and click Import. (F)



Managing and Sharing Your References

RefWorks provides you with a number of tools to organize, edit, find, and view references in your database.

Creating Folders and Sub-Folders

® RefWorks

efWorks database

g New Folder | | Create Bivliography | | © New Reference sastnslinfomaten (" Foiders

£ @ Lostimpoted (0)

References > All References Global Waming (0)

Create New Folder X |4
New Folder Name (Create Subfoiger)
Progeria

Natural Disasters (&)

References | Parkinson's Dissase (0)

Raferences 1o Use
@ Salectes C Page O lintist

Penguins (1)

0 RefID 1383 Probiotics (8)
Authors  Gobbetti i B Gi Lo Create | Cancel
Title Sourdough lactob SR —
Source Food Uicrobiol, 2007, 24,2, 167-190
Folders  Probioics:
uNk

Ei
© reto 1 Jourmal At Reference 2 of 3 sRP0Q A
Autnors Concy 6 G Tota . Calan.c. T
Tite + Advanced sed

Source Lz izl 2008, 10,6, 1208-1215, Engand } impon

roders P Segrie
o \ Feson oapustlo
o i

—_

. Click on the New Folder button.

2. Enter a name in the text box; click Create. (G)
There is no limit on the number of folders or sub-folders you
can create within your RefWorks account.

3. To create a sub-folder, click on New Folder button.

4. Click on the Create sub-folder link.

5. Select a Parent folder for your sub-folder and enter a name
in the New Folder Name text box.

6. Click the Create button to save your sub-folder.

Helpful Hint: The Last Imported folder contains only references
from your most recent data import. References from imports
prior to your last import not assigned to specific folders remain
available in your primary database but unfiled; unfiled references
are called References Not in a Folder and may be seen by
clicking the Organize and Share Folders tab.

Putting References into Folders
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1. Mark desired references from the search results page, then click
the button titled Selected. The selected references feature works
on a page-by-page basis; this means that you must add the
manually selected references to the desired folder before moving
to the next page. Alternatively, you can mark All or all on a Page.

2. Click on the Add To: folder icon (@) and select the appropriate
folder from the drop-down menu. (H)

3. References will automatically be added to the indicated folder.

Helpful Hint: References can be assigned to more than one folder.

Technical Services support@refworks.com

Sorting References

1. From either the View pull-down menu or the Organize & Share
Folders tab, select a folder or group of references.

2. Using the pull-down menu Sort by, located in the toolbar above
the references, choose to view references by various fields within
your database.

Globally Editing References
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. From the main navigation area, click on the Global Edit button (-@).

. Select the appropriate option for Reference to Use.

. The Add option is displayed by default.

. Choose the specific field to edit from the drop-down list. (1)

. Type in the data you want to add to the field in the text field box.

. Select the appropriate option for handling the field - Append to
Existing Data; Overwrite Existing Data (what you currently have
in the field will be gone); Leave Existing Data Alone (if the
field contains data the edit feature will skip over that particular
reference).

7. Click on Add Data.

OO WN =

Helpful Hint: RefWorks also offers the ability to Move, Delete, or
Replace information in records. For more information on these
additional Global Edit functions, please see the Help file.



Managing and Sharing Your References (continued)

RefWorks provides you with a number of tools to organize, edit, find, and view references in your database.

Quick Search

Use the Quick Search feature as a search of all fields. To produce
maximum results, all search terms entered are connected by the
Boolean connector OR. In addition, searches retrieve embedded
terms - a search for “art” retrieves references with “heart,” “part,”
etc. The results of a Quick Search are always ranked by relevancy.

1. Enter search terms in the Search your database box.
2. Click on GO.
3. Results are displayed with the search terms highlighted.

Helpful Hint: Only file attachments saved as .txt files or PDF files
saved in .txt format are searchable. To search file attachments, make
sure the option to search attachments is enabled by clicking on the
paperclip icon (4#) beside the search box.

Advanced Search
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Advanced Search makes it easy to perform field-specific searches
(e.g., Author, Title, Keyword), construct Boolean queries (i.e., AND,
OR, NOT), and limit the search to a specific folder(s). The results
of an Advanced Search are displayed alphabetically by author, with
the search terms highlighted unless a customized sort setting has
been applied.

1. Click on the Search drop-down menu and select Advanced.

2. Enter search terms and corresponding fields into the
Advanced Search menu. Click on ( @ ) to add more fields. (J)

3. Connect the terms by using the Boolean operators.

4. Select All References or specific folders to search.

5. Click on Search.

Helpful Hint: You now have the option to save search strategies.
Search strategies can be named and saved for easy and continual
retrieval.
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Sharing Your References
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Note: RefShare must be turned on by your local RefWorks
Administrator to be available. RefShare is not available for
individual subscriptions.

You can share a folder of references or your entire database.

1. Click on the Organize & Share Folders tab from the main
navigation area. (K)

2. Select the folder you wish to share by clicking on its Share icon.
( i_,g, ). To share your entire database, select the Share icon.
Click Share. Note: Folders which have already been shared will
appear with a different icon. (&)

3. The Sharing Options box displays allowing you to define any
user restrictions you wish to set for the RefShare Recipient(s).
Click Save.

4. To share, click on the Shared Folder icon and select Email this
share ( [=4]). A generic email template and a unique URL
created for your RefShare folder will open. Insert the email
address of the individual(s) you would like to share your
references with. Select Send E-Mail.

Note: RefWorks users can directly export from a shared folder
to their own account, if permissible. As the owner of the folder
or database, you determine the control options your RefShare
Recipient(s) will have in utilizing your shared references.



Creating Your Paper and Bibliography

RefWorks creates bibliographies from over 3,000 output styles in seconds.

Format a Bibliography
From a List of References
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. Click on the Create Bibliography button.

. Select an output format (i.e., APA, MLA, Chicago, etc.).

. Click on Format a Bibliography from a List of References.

. Select what file type to create.

. Select to format all of your references or those references
from My List or from a specific folder.

. Click on Create Bibliography.

. A new window will open with your bibliography. (L)

8. Save your bibliography to your computer or flash drive.
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Editing or Creating Your Output Style

Select Style to Edit
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RefWorks provides thousands of output styles to choose from. If
none of these styles conform to your desired results, the Output
Style Editor allows you to create custom output styles by either

creating a completely new style or modifying an existing output
style to suit your needs.

1. From the Bibliography pull-down menu in the tool bar, select
Output Style Editor.

2. Select the appropriate Style to edit from the drop-down menu
or click on the New button. (M)

Access the Help menu for additional assistance in creating or
editing new bibliographic output styles.
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Note: Write-N-Cite will not reflect the RefWorks 2.0 interface
design until late 2011.

You can create a paper with in-text citations using the RefWorks
Write-N-Cite feature.

—_

. Open a new blank document in Microsoft Word.

2. Lauch Write-N-Cite. (N)

3. Put the cursor in your Microsoft Word document where the
reference should be inserted; click Cite next to the reference
in the RefWorks screen.

4. Save your Microsoft Word document when finished.

Helpful Hint: Write-N-Cite 111 now allows you to work on a paper
and format a bibliography both on-AND off-line. Write-N-Cite Ill is
only available for Windows Users. Write-N-Cite v2.5 is available for
Mac Users. To use Write-N-Cite, download the utility from the Tools
pull-down menu before using. To utilize the off-line-capabilities,
you must first download your database while online. For more
information, please refer to the Help file.

Write-N-Cite Bibliography

This paper will dempnstrate the capabilities of Write-N-Cite T {{372 Bentler, Steve 2008} }. Write-N-
Cite helps users { {54 Dudek, A7, 2008; 69 Ferrindo-Lucas. M.T. 2008} ) with in-text citatians {{52
Gutstein HLB. 2008} ] snd biblicgraphies [ (94 Hall s 8. 2008} )
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1. Launch Write-N-Cite.

N

. Click on Bibliography and select the output style. (0)
3. Click on Create Bibliography. The document will refresh

to be formatted correctly and contain the bibliography.
4. Save your Microsoft Word document.



Creating Your Paper and Bibliography

RefWorks creates bibliographies from over 3,000 output styles in seconds.
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1. Click on the Cite icon (1 ;) on the right side of the appropriate
reference. A Citation Viewer window will appear containing
the citation in an abbreviated format.

2. To cite a second reference in the same location just click on
the Cite icon by any other reference. If you are using a Mac,
you will need to click twice - the first click will activate the
RefWorks program and the second will perform the Cite function.

3. Once you have all of the references you need for a particular
in-text citation, click on the Select button. (P)

4. Simply drag and drop the citation into your word processor
document. Alternatively, you can also go to your word processor,
click on the document where you want the citation inserted and
Paste the citation.

5. Be sure to clear the Citation Viewer window before creating your
next citation.

6. Click on the View icon (Q,) to see the entire reference and to
access the Edit command if you want to make changes.

One Line/Cite View Bibliography

1. Save the document you have just created before formatting
the paper and the bibliography.

2. Click on the Create Bibliography button from within the RefWorks
program.

3. Select the Output Style you need and use the Format Paper and
Bibliography option to browse for the document.

4. Click the Create Bibliography button to format your paper. A new
version of your paper will appear.

5. Save this version with a different name from your draft version.
If you need to make changes, you must use the draft version
and re-format, as you cannot re-format an already formatted
document.
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Direct Exports Available From:

* ABC-CLIO

* ACS Publications

* bibliotek.dk

* BIBSYS

* BioMed Central

* BioOne

* Blackwell Synergy

* CABI

* CAIRN

* Chadwyck-Healey

* Compludoc

*CQ Press

* CSA lllumina

+CSIC

 DanBib - Danish Bibliographic
Centre

* Dawson Books

* DBPIA

 Deep Web Technologies

* Dialnet

* ebrary

* EBSCOhost

* Engineering Village 2

* FIS Bildung

* Google Scholar

* GoPubMed

* HighWire

* HubMed

* |EEE

* Informit

* Japana Centra Revuo
Medicina (Web)

+ JSTOR

* LexisNexis Academic

* MetaLib

* Microsoft Live Search
Academic
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